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Direct space methods solutionDirect space methods solution

EXPO&more International Workshop
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Methods of Structure SolutionMethods of Structure Solution

Structure
 solution
methods

Traditional approaches:

direct methods
Patterson methods

Direct space methods

Alternative words:real space, 
global optimization, global search

Other methods:

charge flipping
molecular replacement
…...............................

W. I. F. David and K. Shankland. Structure determination from powder diffraction data. Acta Cryst. A64, 52 (2008)
https://doi.org/10.1107/S0108767307064252

https://doi.org/10.1107/S0108767307064252
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Global Optimization MethodsGlobal Optimization Methods

Global minimum x*

Local minimum

Local optimization methods Structure refinement

Global optimization methods Structure solution

F:ℝn→ℝFind x*= min{F(x)}, where 

X = fractional coordinates of (x,y,z)       or       

X = postion (x,y,z), orientation (θ, φ, ψ), torsion angles (τ
1
, τ

2
, … τ

n
) of molecular fragments

Local minimum
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA) 
Simulated Annealing (SA)
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch 
…...............................
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA)* 
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch* 
…...............................

(*) employed in solving crystal structure
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA)* 
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch 
…...............................

(*) employed in solving crystal structure

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing
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ΔCF = CF
new

- Cf
old

RND = random number

Simulated annealing algorithm: the annealing stepsSimulated annealing algorithm: the annealing steps

Initial random configuration

Generate trial structure by 
random displacement of 

structural variables

Evaluate the cost function 
(CF) for trial structure

Metropolis: is 
new configuration

better than the previous?
Yes (ΔCF < 0).

Keep new configurationNo  (ΔCF > 0) 

Accept new
Configuration if

exp(-ΔCF/T) > RND
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ΔCF = CF
new

- Cf
old

RND = random number
Initial random configuration

Generate trial structure by 
random displacement of 

structural variables
i=i+1

Evaluate the cost function 
(CF) for trial structure

Metropolis: is 
new configuration

better than the previous?
Yes (ΔCF < 0).

Keep new configurationNo  (ΔCF > 0) 

Accept new
Configuration if

exp(-ΔCF/T) > RND

i=0

Simulated annealing algorithm: the annealing stepsSimulated annealing algorithm: the annealing steps

is i = L ?
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Initial random configuration

i=0

Annealing step
i=i+1

No

Yes

is i = L ?

Simulated annealing algorithm: the annealing stepsSimulated annealing algorithm: the annealing steps
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Initial random configuration

i=0

Annealing step
i=i+1

Temperature reduction
T

k
 = β T

k-1

No

Yes

is i = L ?

Simulated annealing algorithmSimulated annealing algorithm
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Initial random configuration

i=0

Annealing step
i=i+1

Temperature reduction
T

k
 = β T

k-1

Stopping criterion
satisfied?

No

Yes

No

Return the optimal solution

Yes

is i = L ?

Simulated annealing algorithmSimulated annealing algorithm
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Simulated annealing optionsSimulated annealing options

Number of moves  

Number of SA runs

β
L

Initial random configuration

i=0

Annealing step
i=i+1

Temperature reduction
T

k
 = β T

k-1

Stopping criterion
satisfied?

No

Yes

No

Return the optimal solution

Yes

is i = L ?
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Big bang phase
Creation of the population 

expansionexpansion contractioncontraction

Candidate solutions are spread all 
over the search space in a uniform 
manner. Cost function values of 
the individuals are calculated

Big crunch phase
Center of mass is calculated and
chosen as the point of new big
bang phase

Big bang-big crunch optimizationBig bang-big crunch optimization

Hybrid versionHybrid version: SA is applied on selected individuals before the big crunch: SA is applied on selected individuals before the big crunch
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-Do not use chemical knowledge +Can incorporate a massive amount of 
prior chemical information

ComparisonComparison
Traditional approaches Direct space methods

Clegg, W. & Teat, S. J., (2000). Acta Cryst. C56, 1343-1345.

+Complexity of procedure depends on 
the number of degrees of freedom (DoF). 

+High resolution is not needed.  
Default resolution: 2-2.5 Å.

-Take time and patience. For large 
molecules: faster computer, run 
overnight, parallel program

-Complexity of the problem depends 
on the number of non H-atoms in the 
a.u.

-Take advantage by using data of 
higher resolution

+Generally require less time to run

tetracycline (32 non-H atoms and 8 DoF) can 
be solved using global optimization

http://journals.iucr.org/c/issues/2000/11/00/bm1422/index.html
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Building starting modelBuilding starting model

It is necessary to know the molecular connectivity. 
Spectroscopic techniques (MS, NMR) can be useful 

Crystal structure can be described as a combination of building blocks

atom molecule polyhedron



  

E
X

P
O

&
m

or
e

 In
te

rn
a

tio
na

l W
or

ks
ho

p
 (

30
 S

ep
te

m
b

er
 –

 3
 O

ct
o

be
r 

20
1

9)
 -

 B
ar

i, 
It

a
ly

Building starting modelBuilding starting model

Check for similar molecules in databases or in the 

literature

Optimize molecular geometry by computational chemistry 

programs



  

E
X

P
O

&
m

or
e

 In
te

rn
a

tio
na

l W
or

ks
ho

p
 (

30
 S

ep
te

m
b

er
 –

 3
 O

ct
o

be
r 

20
1

9)
 -

 B
ar

i, 
It

a
ly

Free Chemistry DatabasesFree Chemistry Databases

PubChem: https://pubchem.ncbi.nlm.nih.gov/

NIST Chemistry WebBook: http://webbook.nist.gov/chemistry/

Drugbank: http://www.drugbank.ca/

Other databases: ZINC, eMolecules, ChEBI, NMRShiftDB, ...

Chemical file formats: sdf, mol, mol2, 
cml, SMILES, ...

http://www.ba.ic.cnr.it/ochemdb/

https://pubchem.ncbi.nlm.nih.gov/
http://webbook.nist.gov/chemistry/
http://www.drugbank.ca/
http://www.ba.ic.cnr.it/ochemdb/
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Crystal Structure DatabasesCrystal Structure Databases**

CSD (Cambridge Structural Database) (organics & organometallics):

http://www.ccdc.cam.ac.uk/

ICSD (Inorganic Crystal Structure Database) 

(inorganics, elements, minerals & intermetallics): http://icsd.ill.fr/

COD (Crystallography Open Database) (general database): 

http://www.crystallography.net/

Other databases: ICDD PDF-4+, American Mineralogist Crystal Structure 
Database,  MINCRYST, Zeolite Structures Database, ... 

Non-commercial database are in red

File format: CIF (Crystallographic Information File)

*Joint special issue: Acta Cryst. B58, 317-422 (2002)

http://icsd.ill.fr/
http://www.crystallography.net/
https://journals.iucr.org/b/issues/2002/03/01/
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Load crystal structures from COD

“File” menu →  “Import Fragment” menu →  “From COD”

“Modify” menu → “Add Fragments” menu → “From COD”

“View” menu →  “Jav Molecular Viewer”
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Geometry optimizationGeometry optimization

Three levels of theory

Molecular-mechanics force fields (MM) 

Semi-empirical methods (SE)

Ab initio methods: Hartree–Fock methods, density 
functional theory (DFT)

Programs: MOPAC, Gamess, NWChem, Gaussian, ABINIT, 
Quantum ESPRESSO, ORCA, Molpro, Q-Chem, octopus, etc.

Strategy: MM → SI → DFT
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obmodule.f90

The Use of Open BabelThe Use of Open Babel

EXPO2014 Open Babel

Fotran/C++ C++

Molecular-mechanics force fields (MMFF99 
and UFF provided by Open Babel library)

Able to process input and output files of 
common quantum-chemistry packages: 
GAMESS-US, NWChem, Gaussian, 
CRYSTAL, ABINIT, Quantum ESPRESSO 
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Graphical User Interface for MOPAC2016

Geometry optimization by MOPAC

MOPAC2016™ is a semiempirical quantum chemistry software package available FREE 
for academic, not-for-profit use. Download link: http://openmopac.net/downloads.html

http://openmopac.net/downloads.html
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Molecule editorMolecule editor

Sketch molecules in 2D or 3D format 

Optimize the geometry by force field method 

Create input file for the quantum-chemistry calculations 

Read output files of the most common computational packages 

ACD/ChemSketch -  http://www.acdlabs.com 

Avogadro - http://avogadro.openmolecules.net/wiki/Main_Page

MarvinSketch -  http://www.chemaxon.com/products/marvin/

Gabedit: http://gabedit.sourceforge.net/

Some free available software

A molecule editor allows

http://www.acdlabs.com/
http://avogadro.openmolecules.net/wiki/Main_Page
http://www.chemaxon.com/products/marvin/
http://gabedit.sourceforge.net/
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Building starting modelBuilding starting model

3D structure optimization

P 21/a

2-(4-Hydroxy-2-oxo-2,3-dihydro-1,3-benzothiazol-7-yl)
ethylammonium chloride N

frag
 = 2

N
dof

 = 6 + 3 + 2

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac
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Building starting model: example 2Building starting model: example 2

P2
1

N
frag

 = 2
N

dof
 = 6 + 6 + 4 + 4

 S-Ibuprofen

Two molecules in the a.u. (Z’=2)

3D structure 
optimization

Duplicate

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac
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Building starting model: example 3Building starting model: example 3

P 21/a

3D structure optimization

1,4-Bis(2-phenethyloxyethanesulfonyl)piperazine

center of symmetry a.u. is a half molecule
Z’ = 1/2

Structure solution
by DSM + DOC

N
dof

 = 6 + 14

15 times slower

Structure solution
by DSM

N
dof

 = 6 + 7
Recommended 

strategy
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famotidine form B

P 21/c

3D structure optimization

Building starting model: example 4Building starting model: example 4

N
frag

 = 1
N

dof
 = 6 + 6
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Building starting modelBuilding starting model

Stereochemistries will not be altered during simulated annealing.
Attention to compounds with more than one chiral center and cis/trans isomerism

Attention to non planar ring systems or unusual combinations of elements in functional
groups. Check for similar molecules in the CSD or in the literature

or or

trans cis
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Building starting modelBuilding starting model

V
mol

 = number of non-hydrogen atoms · 18   (18 Å3 rule)

∑ ni viV
mol

 = 

or

The volume of the unit cell can be used to determine the number of 
independent building blocks in the asymmetric unit from the known 
crystal density

Average volume occupied by atom ≈ 15 – 20 Å3 

The success of the structure determination depends crucially on the 
accuracy of the input molecular model. 

Experience and chemical intuition are required to build the correct model

n
i
 = number of atoms of the ith type in the structure

v
i
 = volume contribution (in Å3) for the ith atom type

Check V
cell

/V
mol
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H atomsH atoms

H atoms do not contribute significantly to X-ray diffraction, they 
can be ignored during the structure solution

Eliminating the H atoms reduces the number of atoms and DoFs, 
decreasing the time to evaluate CF for each trial structure

Delete H atoms using 
the GUI or using the 
deletehydro directive
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Hydrogen calculationHydrogen calculation

Hydrogen atoms are positioned 
geometrically at X-ray distances

0.82 Å (X-ray) 

X-H (X-ray) < X-H (neutrons)

0.95 Å (neutrons) 
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options

● No. of molecular fragments
● No. of external DoFs
● No. of internal DoFs
● The flexibility of the molecule
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Cost Functions

● Whole profile R factor 

● Integrated intensities R factor 

● Other cost functions: 
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Using expo2014 for direct-space solutionUsing expo2014 for direct-space solution

By input file (*.exp)By input file (*.exp)

%Structure paracetamol
%Job Paracetamol  (C8H9NO2)
%Data
   Cell  7.100  9.380  11.708  90.0  97.42  90.0
   SpaceGroup p 21/n
   Pattern   paracetamol.xy
   Wavelength 1.54056
%fragment paracetamol.mol
%sannel

File → Load and Go

Command-line usageCommand-line usage
expo paracetamol.exp
or
expo paracetamol.exp –nogui
or
expo paracetamol.exp –auto  

Usage of the command %fragment
%fragment tetra AtC AtV [dist]
%fragment octa AtC AtV [dist]
%fragment square AtC AtV [dist]
%fragment cube AtC AtV [dist]
%fragment trigonal AtC AtV [dist]
%fragment prism_tetra AtC AtV [dist]
%fragment prism_trig AtC AtV [dist]
%fragment icosa AtC AtV [dist]
%fragment atoms chem_formula
%fragment smiles SMILES_string
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Molecular compoundsMolecular compounds

Paracetamol (form I polymorph) 
(C

8
H

9
NO

2
) *

*Nichols, C. & Frampton, C. S. (1998). J. Pharm. Sci. 87, 684–693.
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Non-molecular compoundsNon-molecular compounds

Crystal structure of Sb
2
(PO4)

3 
*

*Jouanneaux, A., Verbaere, A., Guyomard, D., Piffard, Y., Oyetola, S. & Fitch, A. N. (1991). Eur. J. Solid State Inorg. Chem. 28, 755-765.

http://www.sciencedirect.com/science/article/pii/S002235491550590X?via%3Dihub
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Non-molecular compoundsNon-molecular compounds

Sb2(PO4)3N
dof

 = 51

N
dof

 = 30

N
dof

 = 24
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Non-molecular compoundsNon-molecular compounds

Some atoms are expected to fall on special position

Different building blocks share some atoms

You cannot know the number and the type of the polyhedra
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

Falcioni, M. & Newsam, J. M. (1989). Nature 342, 260-262.

Favre-Nicolin, V. & Černỳ, R.  (2002). J. Appl. Cryst.. 35, 734-743

occupancy

DOC is able to merge the excess atoms automatically
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

doc

or

doc atom1 atom2 ... 
doc Ni1
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

DOC slows down the computation time so it should be avoid DOC slows down the computation time so it should be avoid 
if no special positions or shared atoms are expected.if no special positions or shared atoms are expected.
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SA applied to non-molecular compoundsSA applied to non-molecular compounds

Sb2(PO4)3

Polyhedra rapresentation of Sb2(PO4)3  
by SA with DOC

SA with DOCSA with DOC
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Delete duplicate atomsDelete duplicate atoms

29 atoms

2 atoms

2 atoms

2 atoms

17 atoms

*

symmetry equivalent atoms *

1.  Modify > Delete Duplicate Atoms
2. Tools > Build Bonds

2 atoms *
*

*
*

*

*

*
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Direct Space with Low Quality Diffraction Pattern

Bond valence restraints Bond valence restraints 

Anti-bumping restraints Anti-bumping restraints 

Molecular geometry restraintsMolecular geometry restraints
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Bond Valence Restraints Bond Valence Restraints 

Atomic valence V
i
 of atom i in crystal structure is the sum of individual bond valences S

ij

distance between atoms i and j

bond valence parameters (bvparmyyyy.cif maintened by I.D. Brown and 
available from http://www.iucr.org/resources/data/datasets/bond-valence-parameters)

The estimated values V
i
 can be incorporated as restraints in the cost function (*): 

* J. Pannetier, J. Bassas-Alsina, J. Rodriguez-Carvajal & V. Caignaert, (1990). Nature 346, 343 - 345

global-instability index
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Check Bond Valence SumCheck Bond Valence Sum

https://www.nature.com/nature/journal/v346/n6282/abs/346343a0.html
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Imposing anti-bumping restraints Imposing anti-bumping restraints 

All nonbonded interactions between 
atoms that are separated by a path of 
bonds containing 4 rotable bonds or 
less are excluded

Only 1-5 interactions are considered
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Imposing anti-bumping restraints Imposing anti-bumping restraints 

%sannel
bump * *
nobump Ag1 N1
nobump Ag1 N2
bscale 0.9

[Ag(pz)]
n 
Hpz = pyrazole

Warning: time-consuming procedure, use only 
if the diffraction data are not of sufficient quality

Directive: 

bump

bump atoms1 atoms2 [dist]

or
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    = distance between two atoms A and B

= ideal distance

= permitted tolerance

= user supplied weight

Molecular Geometry RestraintsMolecular Geometry Restraints

Rarely improve the success rate of the solution search for good quality data

Restraints can slow or prevent a structure solution

Directive: 

rest  A  B  d
target

  tol

d
target 

and tol are optional: 

rest  A  B
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Non planar ring systems

Attention to non planar ring systems or unusual combinations 
of elements in functional groups
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Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride**

DS
DOF = 6+3+7

DS
DOF = 6+3+12 Published

DSM

RMSD=0.054 Å 

NO SOLUTION!

Geometry optimization by DFT
(NWchem, B3LYP/6-31G*)

*Kojic Prodic, B., Ruzic Toros, Z., Sunjic, V., Decorte, E. & Moimas, F. (1984). Helv. Chim. Acta, 67, 916–925.
https://doi.org/10.1002/hlca.19840670333
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%Structure diltia
%Job diltiazem HydrochlorideHydrochloride 
%Data
Cell   42.190  9.075  6.037  90  90  90
SpaceGroup p 21 21 21
Content    c 88 n 8 o 16 s 4 cl 4 h 108
Pattern    pd_0029.pow
Wavelength 1.54056
%fragment diltia_nw_noH_break.mol
%fragment atoms Cl
%sannel
nrun 100
niter 5000
rest C3 C4
%save diltia.expo

Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride

https://doi.org/10.1002/hlca.19840670333
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Supercomputers Marconi by CINECA  (Italy)
244.800 cores in total

Notebooks Typically2-6 cores

Smartphones Typically2-10 cores

Workstations
Typically4-56 cores

Graphical Processing Units Up to 3000 cores

Parallel Machines
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Three Programming models

Message Passing Interface (MPI)

Open MultiProcessing (OpenMP)

Compute Unified Device Architecture (CUDA)
Open Computing Language (OpenCL) 

Distributed-memory architecture

Shared-memory architecture

Coprocessor architecture 
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Three Programming models

Message Passing Interface (MPI)

Open MultiProcessing (OpenMP)

Compute Unified Device Architecture (CUDA)
Open Computing Language (OpenCL) 

Distributed-memory architecture

Shared-memory architecture

Coprocessor architecture 
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Message Passing Interface (MPI)

mpirun -np 3 expo input_file.exp

Time

0: expo2014
4 runs

3 runs

3 runs

MPI barrier

1: expo2014

2: expo2014
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Running the Parallel Version of EXPO2014

Computer with multi-core CPUs and Linux environment.

Open MPI installed.

Compiling EXPO2014 from source and linking with MPI libraries

Run Expo2014 by using the launcher mpirun with the appropriate options.

mpirun -np 10 expo input_file.exp
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EXPO2014 Virtual Machine

Intel(R) Core(TM) i7-8700 CPU @ 3.20GHz

http://www.ba.ic.cnr.it/softwareic/expo/parallelism-in-expo2014-for-structure-solution-by-direct-
space-method/

Download and installation

T
im

e
 (

m
in

.)
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DOF
Internal: 20
External: 6

Algorithm settings
NRUN: 100
NITER: 1000

Time
Single CPU-core: 500 h 
20 CPU-cores: 25 h
Parallel speedup: 20

Z-(Aib)
5
-O-t-Bu

Structure solution of small peptide

E. Benedetti, A. Bavoso, B. Di Blasio, V. Pavone, C. Pedone, M. Crisma, G. M. Bonora, and C. Toniolo, J. Am.Chem. 
Soc. 104, 2437 (1982)

Published

DSM

RMSD=0.0746 Å 
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Published

DSM

DOF = 6+53

RMSD=0.0746 Å 

%job beta-1,2,3-tris(heptadecanoyl)glycerol (beta-C17C17C17)
%structure glycerol17
%data
pattern av0044C17C17C17sup3.rtv
wave 0.850047
synch
space P-1
cell 11.86642 51.4495 5.43208 72.765 100.0950 120.577
%fragment glycerol17_rand.mol
%sannel
nrun 100
bump
%save glycerol17.expo

Structure of mono-acid β-triacylglycerols

Robert B. Helmholdt, René Peschar and Henk Schenk. Acta Cryst. (2002). B58,134±139
https://doi.org/10.1107/S0108768101016330

20 CPU-cores: 290 h
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Assessing the solutionAssessing the solution

Reproducibility of solution

Agreements factors
Visual match between calculated and observed profile

http://www.ba.ic.cnr.it/softwareic/expo/parallelism-in-expo2014-for-structure-solution-by-direct-space-method/
http://www.ba.ic.cnr.it/softwareic/expo/parallelism-in-expo2014-for-structure-solution-by-direct-space-method/
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Display difference Fourier map

Assessing the solutionAssessing the solution

correct structurecorrect structure

wrong structurewrong structure
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Assessing the solutionAssessing the solution

Crystal packing

Network of interactions: hydrogen bonds and short contacts

Check close contacts, void spaces, likely iterations

https://doi.org/10.1107/S0108768101016330
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Starting model is incorrect: 
chemical formula is wrong
bond distance and angle are not entirely accurate
number of building blocks is wrong
missing solvent
  …................  

Check the compositional information (MS, SEM/EDS, XRF, ICP, NMR)
Try different combination of building blocks
Check the molecular stereochemistry, or ring conformation
Improve your model with CSD or building package 

Solution:Solution:

When Structure Solution FailsWhen Structure Solution Fails
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Poor quality diffraction pattern

When Structure Solution FailsWhen Structure Solution Fails

Collect new data
Add restraints or anti-bump restraints

Systematic problem in powder diffraction data

Solution:Solution:

Collect new data
Refine preferred orientation parameters

Solution:Solution:

Preferred orientation
Kα2 contributions
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When Structure Solution FailsWhen Structure Solution Fails

For complex structure (internal DOF > 10) the default SA conditions can 
be not sufficient

Solution:Solution:
Increase the number of moves (niter 
directive) and/or runs (nrun directive)
Try with slower temperature reduction

The assumptions about thermal factors are invalid 

Solution:Solution:
Try altering the non-hydrogen atom temperature factors
Check temperature factors for similar structure
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When Structure Solution FailsWhen Structure Solution Fails

Space group and cell are not correct

Solution:Solution:
It may be necessary to carry out a series of independent calculations 
to test different potential space groups and/or unit-cell choices
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%job Sample_ID_1h  
%structure sample1h

%data
pattern cpd-1h.dat
wave 1.54056 1.54439 0.5

%crystal
name Al2O3
cell 4.75920   4.75920   12.992   90   90   120
space R-3c
fragment atoms Al O
doc

%crystal
name CaF2
cell 5.4649   5.4649   5.4649  90   90   90
space F m3m
fragment atoms Ca F
doc

%crystal
name ZnO
cell  3.2501   3.2501   5.2071   90   90   120
space P 63mc
fragment atoms Zn O
doc

%sannel

Multiple phase powder diffraction patterns

J. Appl. Cryst. (2001). 34, 409-426
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%data
pattern L1.TXT
wavelength 1.54056

%crystal
name phase1
cell 7.4512 10.1767 13.2955 90 94.481 90
space P21/c
fragment  phase1_mopac_noHbis.mol

%crystal
name phase2
file pahse2_1single.cif
fixed

%sannel

Multiple phase powder diffraction patterns

Known crystal phase

Unkown crystal phase

Fix the known phase during the optimization
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Optimization of the molecular geometry to obtain accurate starting models

Restraints in the Rietveld refinement

H atoms

Refinement of crystal structure

Solve ambiguities 
(e.g., space groups, torsion angles)

Validation of experimental crystal structures

Combined powder X-ray diffraction data and Combined powder X-ray diffraction data and 
quantum-chemical calculationsquantum-chemical calculations

Two possible orientations of the pyridyl ring in the 
piroxicam molecule (Naelapää, K., van de Streek, J., 
Rantanen, J., and Bond, A. D. (2012), 
J.Pharm. Sci. 101, 4214–4219)
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Assessing the solution with DFT-DAssessing the solution with DFT-D

Theoretical approach: plane wave (PW) density functional theory with 
dispersion correction (DFT-D)

RMSD for non H-atoms above 0.25 Å could indicate incorrect experimental 
crystal structure *

*Jacco ven de Streek et al. Validation of molecular crystal structures Acta Cryst. (2010). B66, 544–558

Experimental crystal structure

DFT-D3 with NWChem

Ibuprofen

RMSD=0.023 Å 

https://doi.org/10.1107/S0021889801007476
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Software Academic price (€) Link

VASP 4,000 www.vasp.at

CASTEP 1,800 www.castep.org

CRYSTAL 1,000 www.crystal.unito.it

Quantum ESPRESSO free www.quantum-espresso.org

NWChem free www.nwchem-sw.org

Abinit free www.abinit.org

Hardware: multi-core Linux Workstation

Time: approx. 100 hrs for small molecules on single CPU

DFT-D: HowtoDFT-D: Howto
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Contact, software download and info
http://www.ba.ic.cnr.it/softwareic/expo/
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